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Disclaimer:
The Beta build of Smaart v8 is available to users wishing to experience the “bleeding edge” software version
that is still in development. While using the Beta you may encounter bugs, crashes, unexpected behavior,
and awesome features.
Please send crash/bug reports and feedback to support@rationalacoustics.com. Include as much detail as
possible when describing how you encountered a bug or crash. Providing a step-by-step scenario for
reproducing the bug/crash is immensely helpful and makes it much easier to track down the source of the
problem. If a crash dump is available, please send that as well as the exact revision number of the build.
For more information about collecting crash dumps, see our KB article here:
http://rationalacoustics.com/support/035205-Smaart-keeps-crashing
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Beta Build vs. Release Build
The Beta and Release builds have been carefully segregated to allow both to be installed on the same
computer without interfering with each other. Both builds use the same licensing, so there is no licensing
change required if Smaart v8 is already activated on the computer. The configuration file is stored in a
different location for each build, however both builds reference the same trace file location. The default
installation directory for Windows is different for each build; the OS X app bundle name is different for each
build (you can place both in the Applications folder).
The Beta build displays the word “BETA” in red letters in the title bar of the application. The “About” dialog
displays “Smaart v8 Beta” as the application name, and lists both the upcoming “target” major version as well
as the revision number of the build. The revision number is the precise revision that was used to generate the
Beta build.
When new Beta builds become available, use File -> Check for Updates… within Smaart to download and
install the new version. The Beta and Release builds are on different update cycles, and update
independently, as the Beta will be updated more frequently.
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8.5 Features Outline
New features in 8.5 Rev 8093:
• IR Mode Overhaul
⁃ IR Data Bar - mimics RT Mode Data Bar in form and function (Trace Info, Trace Color, nested folders, etc)
⁃ Measure, view, and compare multiple IR measurements in the same plot
⁃ Optimizations to limit system resources necessary for calculating and plotting multiple IRs
⁃ IR Mode Plot Legend with "Sync Ld" function
⁃ Decay Markers stored in Wave file - easily manipulate marker positions and resave
• Improved STI calculations
• “All Bands” dialog now shows all bands by default, instead of just some bands
• New controls for manipulating IR Spectrograph
• Separate Command Bars for RT and IR Modes
• User-defined Filter option for IR Mode
• Improved IR highpass filter and added lowpass filter (access from IR Options)
• Banding can now be applied to IR Frequency and IR Spectrograph Plots - enable option from IR Options
• IR "Peak to Delay" now uses current filter (previously always used Broadband data's peak)
• IR Options reworked to fit new controls
• IR Mode Plots now have independent Y axis panning
• Added Option to change IR Mode frequency-domain plot scales
• All Bands window position is now persistent
• Improved IR saddle point calculation
• Added new MTW+ option for Transfer Function measurements
• Added support for importing Transfer Function data from Meyer Sound SIM®1 3 .bin files via Import ASCII
• Import ASCII now supports Coherence data
• API - Added generic command mechanism for passing keypresses (hotkeys) to Smaart via the API
• Live IR is now always calculated even if the LIR plot is not visible
• Improved “Unwrap Phase” - now unwraps from specified frequency center, control located in the Phase plot
• SPL History plot is now a drag-and-drop target for log files
• Pseudorandom Noise now has a static seed (no longer re-seeded every time the Generator is started)
• Windows users - launching Smaart while it's already open now calls the program to the top of the app stack
• PDF SPL Reports - Generate Report now creates color PDFs
• Added “Peak” option to Advanced Meter Config to support unweighted and weighted Peak sound level metrics
• Added “C-A” metric option to Advanced Meter Config
• Alarm indicators are now always shown in SPL History, even if relevant metrics are hidden
• Alarm level lines are now hidden if no associated metric is shown in SPL History plot
• Added Alarm indicator hover text that shows the metric and timestamp
• "Exposure N" and "Exposure O" now calculate by default
• Added differential Exposure display below SPL History graph
• Logger now automatically starts a new log file after log file is 24 hours long
• If all calibrated inputs/devices are removed while logging is enabled, logging now stops
• Added right-click menu for opening file location to SPL log file path field in SPL History component
• Option to open email client at attach SPL Report after generating
• Option to stop signal generator immediately after Capture/Capture All/Recapture/IR Capture
• Advanced Delay Finder - octave-filtered delay measurement with user-adjustable center frequency
• Single "Import Trace" function for importing all measurement types
• Trace Colorizer for assigning new random color to a selection of traces
• “Use Comma as Decimal Mark in Logs” setting now applies to all exported text files

1

SIM® is a registered trademark of Meyer Sound Laboratories, Incorporated.
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• Add "No logging inputs available" to web browser page if nothing is available
• Quick access to Trace Info – press Enter key when trace is selected, Esc closes dialog
• Save As via Data Library now allows you to rename the trace (instead of only choosing a new directory)
• "New Tab" hotkey is now Alt+Shift+T
• "Gain Reporter" controls are now conditionally shown, only if SIO is connected
• "G" hotkey now works when Sig Gen Options is open
• Removed resize capability for Trace Info dialog
• Fixed bug where SPL Alarms were no longer presenting in the web viewer
• Fixed a bug where custom SPL metrics were being removed from Advanced Meter Config in error, while duplicates
were being culled
• Fixed a bug where adding an existing measurement to a new Tab or Window did not copy existing measurement's
settings
• Fixed a bug where STI Qualifications ("grade") were using a different precision compared to the STI result field
• Fixed a bug where Capture All was not storing traces in the same order as the measurement engine order
• Fixed a bug where the legacy API was returning the wrong value when Smoothing was set to None
• Fixed issues with webviewer not initializing properly on the first load
• Fixed a bug with LF noise that was below Mag Threshold making it into measurements using MTW with 96k devices
• Fixed a bug where deleting a custom metric after viewing only that metric in SPL History prevented further graphing
• Fixed a bug where Alarm indicators could be mislabeled if the Alarms were reconfigured after initial configuration
and logging
• Fixed a bug where Clips/Leq Resets were added to the beginning of a log file at the time that they occurred, even if
they occurred before logging began
• Fixed a bug where re-starting Smaart immediately after exiting would corrupt the configuration if the Smaart
process wasn't finished exiting (Windows only)
• Fixed a bug where calling default Plot View 7 (IR Log) when in IR Mode brought you to RT Mode.
• Fixed a bug where moving the top Spectrograph threshold widget to the top of the plot made it impossible to move
after letting go (it was behind the plot-type widget)
• Fixed a bug where View Presets appeared to be deleted because of a corrupted config after updating Smaart
• Fixed a bug where the Measurement Config (hammer/wrench) button didn't work in IR Mode if there were no TF
pairs configured
• Fixed a bug where a newly-captured Transfer Function trace wouldn't appear in Client Window until hidden/shown
• Fixed a bug where renaming a Spectrum measurement didn't update the plot name label if Multi-Spectrum View
was active
• Fixed a bug where Coherence Blanking was using non-squared data even if the "Squared Coh" option was enabled
• Fixed issues with scrolling while editing fields in various tables
• Fixed a bug where log files would include Max Level resets that occurred prior to the start of logging
• Fixed a bug where SPL History and PDF Report graphs didn't match during Alarm events
• Fixed a bug where TF averages using the Power option wouldn’t normalize properly if some of the contributing
traces had data below the Mag Threshold level
• Fixed a bug where Data Bar width wasn't being saved to config unless some other change triggered a save
• Fixed a bug where FTW wouldn't apply to captured traces until it was toggled off/on
• Fixed a precision issue with TF Magnitude Thresholding when using 96k sample rate
• Fixed a bug where the "Calibration Progress" dialog was re-sampling the "Measured Level" if the Offset field was
edited
• Fixed a bug in the period-matched noise generator that could produce a spike at nyquist
• Fixed a bug where automatic removal of duplicate custom SPL metrics unintentionally removed other custom
metrics
• Fixes various crashes related to changing the sampling rate
• Fixed numerous crashes, deadlocks, and bugs that were introduced during 8.5 development
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Overview
This Beta build includes a major overhaul of Impulse Response Mode, new features and improvements
related to SPL measurements, the return of the new Advanced Delay Finder (now optional), and numerous
bug and crash fixes. The primary focus of the IR Mode overhaul is to allow measuring, viewing, and
manipulating multiple IR measurements simultaneously. The user experience in IR Mode is now similar in
many ways to Real Time Mode, making it extremely easy to capture and analyze multiple Impulse Responses.
An IR Mode Data Bar has been added to facilitate easy access to your IR measurement library, and all
configured Transfer Function measurement pairs for a given Tab can be measured simultaneously using the
new IR Mode Control Bar layout.
Note: IR Mode has been optimized to use less system resources than previous versions, however
manipulating multiple IR measurements still requires significant graphics and CPU bandwidth, so it’s possible
that slower computers may not be able to take full advantage of the new Multi IR capabilities. “Business”
laptops should have no problem loading and manipulating 3-4 IR measurements simultaneously.

IR Mode Overhaul
This Beta Readme will only cover the changes in Impulse Response Mode in 8.5 compared to 8.4. For general
information about Impulse Response Mode please refer to the Smaart v8 User Guide.

IR Data Bar
An IR Data Bar has been added to IR Mode, mimicking the Real Time Mode Data Bars in virtually every way.
See the program Help Files “Data Bar Overview” topic for more information about general Data Bar behavior.
The IR Data Bar library points to the “Impulse” folder in /Documents/Smaart v8/ on your computer. To
import old Impulse Response measurement for the first time, simply place them in the “Impulse” folder then
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open Smaart. The measurements will automatically populate in the IR Data Bar library. Alternatively, use File>Import->Trace Data File or Trace Folder to import individual IRs or folders of IRs.
By default, standard wave files or IRs from older version of Smaart will be assigned a default green color.
Multi-select all newly imported IRs, right-click them, and choose “Assign Random Color” to randomly colorize
them. This new feature is available in all data libraries in Smaart.
Decay Marker positions are now stored within the IR wave file (they were previously stored in a separate CSV
file), in the wave file header. After making adjustments to Decay Marker positions, click the “Save” button at
the bottom of the Data Bar to overwrite the old positions. The “Save” function will save marker positions
changes to existing IRs, but it’s also analogous to the “Capture” function in Real Time Mode. After taking an
IR measurement, it is not permanently stored until you click “Save”. The “Save All” button can be used to
save changes to all visible IRs that have been modified, but it also functions like “Capture All” when all visible
IRs are unsaved.

IR Control Bar
The IR Mode Control Bar lists all Transfer Function pairs that are configured for the application Tab in focus. If
only one Transfer Function pair is configured, simple press the triangular Play button to capture an Impulse
Response measurement from it. If more than one TF pair is configured, checkboxes appear to the right of
each pair’s name. Click the checkbox to activate that pair for the next IR measurement. All selected TF pairs
will be measured each time you click the triangular Play button.
After the Impulse Response measurement completes, the IR data is automatically shown in the plots. Trigger
another IR measurement will automatically clear the cached IR measurement data and show the newly
acquired data. To save the IR measurement data, use the “Save” or “Save All” buttons in the Data Bar (see
section above titled “IR Data Bar”).
If the “Cont” button is depressed, all TF pairs will be sampled continuously, and the plot will be updated in
real-time, until the square Stop button is clicked. Note: this will bring many computers to a crawl if more than
a few TF pairs are selected.
If the circle “Record” button is depressed, clicking Play will start a wave recording for the measurement
channel of each TF pair, and the recording will only stop when you click the square Stop button. Note:
graphing the IR of long wave files will also bring many computers to a crawl. You have been warned.
Clicking the circular Delay Tracker button next to each TF pair’s delay time field will trigger a “Peak to Delay”
call and set the TF pair’s delay time to whatever the peak time is for the measured IR dataset for that
measurement pair.

A note about the All Bands table
The All Bands table is a modeless dialog, so it can remain open while you manipulate the main Smaart
program window. The All Bands table is calculated based on whatever IR trace is on the top of the plot Zorder, so you can change the Z-order with All Bands open and it will update in real-time.
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IR Plots and Plot Legend
Many IRs can be displayed and compared in the same plot. The Spectrograph plot is the only plot type that
does not allow multiple IR traces to be overlayed, just like the Real Time Mode Spectrograph. IR trace
manipulation (dB offset, Z order handling, etc) works identically to RT Mode in pretty much every way.
The IR Mode Plot Legend is located in the top-right corner of each IR Plot, and it works just like the RT Mode
Plot Legend with the addition of a “Sync Ld” function. Sync Ld offsets all IR traces so that they overlap at the
top trace’s Ld marker position. This command can also be triggered by using the [Shift + Right-click] hotkey.
By default, IR data traces are optimized before graphing; only to “top” of the IR trace is plotted (instead of all
values in the dataset). To turn this optimization off, go to Options->Impulse Response and uncheck the setting
for “Optimize Graphing”.

New IR Spectrograph Controls
The IR Spectrograph controls have been enhanced to provide greater
flexibility and precision. The “Overlap” (%) control has been replaced
with controls for:
Interval (ms): time between consecutive FFTs
Duration (ms): specify a stopping point to save system resources
Banding or Smoothing: apply Banding or Smoothing to the underlying
data.

Improved STI Calculation Method and Process
The STI calculation dialog in IR Mode has been overhauled. The new user interface is more approachable and
a bit more foolproof than the old implementation. STI can be calculated from any suitable impulse response
measurement that is captured using v8.5+. If an IR was captured using earlier versions of Smaart, or captured
outside of Smaart, only the “Noiseless” calculation method is supported, requiring the input of measured
“Speech Level” and “Noise Level” values to produce
accurate results. If an impulse response measurement is
not suitable for calculating STI, or necessary input
parameters are missing, the dialog prints an error
describing the problem. Relevant STI calculation
parameters can be stored to the IR wav file header after the
calculation completes.
Additionally, under-the-hood improvements have been
made to ensure the highest possible accuracy when using
this indirect method for STI calculation. The full m value
tables for both STI and STI(PA) can now be copied to the
Clipboard for external analysis.
Acquiring a suitable impulse response measurement, choosing the correct measurement type for the system
under test, and providing accurate input parameters requires a thorough understanding of the STI standard
to achieve trustworthy results. The Smaart v8 User Guide will be updated to include a comprehensive section
explaining STI and the measurement process.
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PDF SPL Reports
The Generate Report function for creating summaries of SPL Log files now produces color PDFs. The creation
process is similar to the process in 8.4: choose a time region of the log file from which you want to generate a
report using the SPL History dialog, then click “Generate Report”. A dialog appears allowing you to add notes
and choose which metrics are included in the report. There is an option to “Open file location when done”,
and “Email Report”. Clicking “Email Report” will attempt to open the default mail client and attach the PDF to
a new email. Note: in Windows, this only works for mail clients that support the MAPI protocol. In macOS,
this only works with Apple’s Mail app. This feature will be expanded in the future.

The PDF report contains a header region similar to the old text file version of these reports, a color graph
with all metrics plotted, and separate graphs showing each individual metric.

Advanced Delay Finder
The new Delay Finder dialog is a modeless window that contains more advanced filtering and analysis
capabilities than the prior version. After triggering a delay “Find”, click the “Advanced” button to access the
Advanced Delay Finder.

An impulse analysis plot is provided at the top of the dialog, showing the result of the measurement. The
locked cursor is automatically set to the highest peak found in the ETC/IR. The locked cursor can be moved
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manually using the standard locked cursor commands (see Help Files). Note: the Transfer Function
measurement does not need to be running to use the Advanced Delay finder; it will sample the TF pairs
directly even if the measurement is not running in the background. You can also toggle the Generator on and
off using the G hotkey even with the Advanced Delay Finder in focus.

Delay Measurement Controls
Find Button: Re-runs the IR measurement using the selected transfer function measurement pair.
Insert: Replaces the current delay setting in the selected Transfer Function measurement pair.
Store: Creates a new table entry with the found delay time (locked cursor time coordinate from plot).
Status Bar: Shows the status of the IR measurement when the measurement is running. See current delay
locator for behavior.

Filtering
An arbitrary-frequency bandpass filter can be applied to the IR measurement to further isolate the
measurement. The filter controls consist of a “Filter” button to turn filtering on and off and a text field that
accepts an integer number of Hz for the center frequency of the filter. Both controls are located in the topright corner of the IR plot.
The upper limit for the center frequency is 73% of the Nyquist frequency for the sampling rate used to record
the impulse response. The lower limit is 20 (Hz). At frequencies between the lower limit and 40% of the
Nyquist frequency for the current sample rate, a one-octave wide filter is used. A 1/3-octave wide filter will
be used between 40% and 73% of Nyquist.
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Delay Table
The Delay Table provides a way to store multiple measured delay times for quick access.
•

Clicking the “Store” button to the left of the table creates a new table entry with the found delay
time (or locked cursor time coordinate from plot).

•

Selecting the T0 box makes that entry the new “Measured” delay time (to the left of the table) and
updates all Delta values against that. Clicking “Insert” will then insert the “Measured” delay time into
the current Transfer Function measurement engine.

•

The Name column is editable. Selecting it highlights that row, double selecting the Name allows you
to re-name that row. A selected entry may be moved up or down in order, or deleted, using the
controls below the table.

•

Δ Delay is calculated by subtracting the absolute delay time in the selected T 0 row from the delay
time setting in each row.

•

Δ Distance is calculated based on each row’s Δ Delay and current global Speed of Sound setting
specified in General Options dialog.

MTW+
MTW+ is a supercharged version of MTW that uses more FFTs across the
measured frequency range and reduces gaps in the MTW calculation
pipeline that may result in missing rapid transient events. MTW+ uses a
Hamming data window, while MTW uses a Hann window. At this time it is
not possible to average MTW+ traces with traces derived from
MTW/power-of-2 FFTs.
MTW+ is available as an FFT choice on a global or per-measurement level,
and it supports both 48k and 96k sample rates. The program default is
still “MTW”.

Meyer Sound SIM® .bin Import
The “Import ASCII” dialog now supports importing SIM® 3 .bin files. Simply choose “SIM .bin” in the FFT
droplist, then browse to the location of the .bin file and choose it. Note: SIM® .bin files pair with a
corresponding .xml file, which must be in the same directory as the .bin file for the import to succeed.
At this time, only Transfer Function data is extracted from the .bin file. Each measurement group within the
.bin is analyzed and the Room, Processor, and Result data is extracted to separate Smaart .trf trace files. For
consistency, the extracted Coherence data is square-rooted; if the desire is to emulate a SIM® machine’s
display, enable the “Squared Coherence” setting in Transfer Function Options to square all Coherence traces
prior to display.
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